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1. Getting Started 

1.1 Introduction 
 
The Lin4WinXP software enables a PC with Windows to control the Lindos 
LA100, MS10 or MS1 Audio Analysers via a serial link. It provides a simple 
way of accessing the standard features using a graphical user interface 
rather than operating the units from their front panels. Automatic test 
sequences and frequency sweeps can be run under computer control and 
the results displayed, printed, uploaded to the Lindos Test Sheet Database 
for public viewing or saved to disc. Tolerance testing allows all results to be 
checked against pass/fail tolerances. This all works in a similar way to 
operation from the front panels so existing users should find it easy to use. 
The Windows software provides many more options with a simpler user 
interface.  
 
Graphs can be printed as large as the printer will allow and a rich set of 
options allows the colours, styles and overlays to be controlled. Tolerance 
masks can be shown on the graphs and the grid density and labelling can be 
easily adjusted. 
 
This manual refers to Lin4WinXP v5.30. Please refer to accompanying 
update sheets or to the ReadMe file on disc if you have a later version. If you 
are upgrading from an earlier version refer to appendix B for a list of new 
features. If you are new to Windows refer to appendix C for an explanation of 
the common dialog boxes. 
 
Please send any comments, suggestions or bug reports to Lindos 
Electronics.  

1.2 Installing the Software 
Put the supplied CD into a Compact Disc Drive and double click on the drive 
icon in 'My Computer' or an equivalent short cut. Double click on the Setup 
file to install Lin4WinXP on your hard disc.  If you encounter any problems 
installing the software restart the computer, ensure that no other applications 
are running and try again. 
 
The software will work with Windows 95, 98, NT3, NT4, 2000, ME or XP. 
 
To run Lin4WinXP click on the Windows Start button, follow the programs 
menu arrow and click on the Lin4WinXP icon. 
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1.3 Connecting the LA100 
The full software pack normally comes without connecting leads. Users 
upgrading from the Lindos DSK2, DSK4, Lin4Win v2.1 or Lin4Win2000 
software should already have suitable leads which for older units are: 
 
 9 pin D plug to 5 pin domino DIN (3m long) 
 5 pin domino DIN to 5 pin domino DIN (1m long) 
 
The LA100 MK3 interfaces using two standard D-type to D-type RS232 leads 
which are supplied with all new and upgraded units. 
 
Plug the 9 way D plug into the PC serial port labelled SERIAL (or COM1), 
and plug the other end into the LA101 or the LA102.  If the computer has a 
25 way serial port you will need an adapter plug or a different lead. 
 
The other lead should then be used to connect the LA101 and the LA102 
together. The two serial interface sockets on each unit are connected in 
parallel, so it doesn't matter which one is used, but note that when using 
domino DIN leads the notch should be towards the left when looking in to the 
socket (most LA100 units have a keyed socket, but a few were shipped with 
non-keyed sockets). You 
can connect the LA100 to 
COM2, COM3 or COM4 if 
COM1 is already used but 
you will need to change the 
serial port option by clicking 
on Comms Setting from the 
options menu, which can 
be found at the top of the main results window. 
 
When the LA101 and LA102 are daisy-chained like this the LA102 provides 
the handshake signal back to the computer.  This means that the LA101 can 
be disconnected and the LA102 used by itself with the computer.  However, 
if the LA101 is to be used on its own a dummy handshake plug must be 
plugged into the unused socket on the LA101 to return the computer’s own 
handshake (a domino DIN plug with pins 2 and 5 connected together is 
available from Lindos on request). 
 
No special settings are needed in the LA100, Lin4WinXP will automatically 
detect which baud rate the LA100 is set to and reconfigure it for 9600 baud.  
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When the LA100 is connected to the computer its own keyboard can still 
control it.  The computer will take over and disable the LA100 keyboard when 
it needs to, but it will return the LA100 to manual mode as soon as it has 
finished. If the LA100 is ever left in REMOTE mode tap the [ON/OFF] key 
briefly to put it into manual mode, but this shouldn‘t be necessary. 

1.4 Connecting the MS1/MS10 
All MiniSonic devices are supplied with Lin4WinXP and a D-type to D-type 
RS232 lead.  
 
Connect the female D-type to the PC’s serial port and the male D-type to 
the MiniSonic’s RS232 port. Take care to not plug into the audio input or 
outputs as this will cause the UniSon PowerBus to become shorted 
resulting in a loss of power from the unit. The MiniSonic’s power circuits 
are internally protected so no damaged will be caused should this 
accidentally occur.      
 
The MiniSonic can be connected to COM2, COM3 or COM4 if COM1 is 
already used but you will need to change the serial port option from 
Options/Comms Setting on the menus listed at the top of the main results 
window. 

1.5 Basics 
Double-click on the Lin4WinXP icon to start the program and after a few 
seconds the main window and ‘Control Panel’ will open.  
 
If the computer has a firewall installed it will probably prompt whether to allow 
Lin4WinXP to access the Internet. Lin4WinXP needs Internet access to 
publish test results to the Lindos web site and to download updates, but it will 
function without Internet access if you wish to keep blocking it. Refer to your 
firewall documentation for further details. 
 
If no device is present the status bar at the bottom left of the control panel will 
turn red and flash the message “No unit Connected (no handshake) on 
COM1”.  Return to the previous section if this occurs or see appendix A if you 
suspect baud rate problems.  
 
Once a connection is established the panel message will change, to show 
the device connected along with its serial number and firmware version. 
 
For example “LA100 5077 V6.7” or “MiniSonic 0001 M3.0”. 
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The software requires a licence keyfile to function fully with an LA100 unit, 
(MiniSonics units work in full with all versions straight away).  If the LA100 is 
not licensed a message will appear offering to connect to the internet and 
download the latest Userkey file or continue in demonstration mode. The 
Userkey file contains a list of all the currently licensed LA100s. If the PC 
being used doesn’t have an Internet connection the Userkey.dat file can be 
download manually from www.lindos.co.uk/lin4win.html and copied over the 
existing ‘Userkey.dat’ in the ‘Lin4WinXP’ installation directory (normally in 
C:/Program Files).  
 
The tool bar at the top of the main window provides the following functions: 

 
Audio test results are displayed in the main window, which uses a multi-
document interface (MDI) to enable multiple results to be displayed in sub-
windows within this main window. The test results may be from automatic 
test sequences, frequency sweeps, data logging or test procedures. It 
doesn‘t matter how they were generated as they are all treated in the same 
way. 
 
All of the program‘s features can be accessed from the menus. The button 
bar and control keys also give quick access to the common features (for 
example Ctrl-P to print, Ctrl-S to save, Ctrl-O to open a file etc).  Some 
common operations can also be accessed by double-clicking over the graph 
or text results. 
 
Sequences can be run by entering a list of segment letters into the ‘Quick 
Sequence’ box on the toolbar, through the menus or via the control panel. 
Note that all MiniSonic segments are lower case letters and the majority of 
LA100 uppercase. If connection to the device proceeded smoothly, as 
described above, try entering ‘U’ or ‘u’ and pressing return. Assuming that a 
signal path is available between the output and input the device will 
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immediately run and receive a stereo sweep. It is also worth noting that the 
MiniSonic can communicate with an LA100 (i.e. entering ‘U’ with a MiniSonic 
connected will produce an LA100 sweep) and will generate and receive 
some LA100 segments (see section 4.6 of the MiniSonic manual for further 
details). 
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2. Sequence Handling 

2.1 File Handling 
Use the file menu to load or save results. Results files have a RES file 
extension and are typically just 2K bytes in size. Sample Results and 
Tolerance files are provided with the software in directories named Results 
and Tolerances, which can be found in the directory that the software was 
installed to (normally C:/Program Files/Lin4WinXP).    
 
Results files can be loaded by clicking on Open in the File menu or by 
dragging and dropping them into the main window. Please see appendix C if 
you are new to Windows. The results will be displayed in a new window. 
Use the Open  menu entry to load the demo.res results file. 
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Results may be saved using the File Save menu or by clicking on the Save 
button (the floppy disc icon).  Ctrl-O and Ctrl-S can also be used to access 
the open and save dialogs quickly.  

2.2 Results Display 
Sequence results are shown in a window with the graphs beside the text, as 
on an LA102 printout. This window can be scrolled up and down using the 
standard Windows scroll bar, scroll buttons or wheel mouse. It can also be 
scrolled with the Page Up and Page Down and cursor up/down keys. 
 
Graph options can be used to change the size, scale, colour, normalisation 
or style of the graph as described in section 5.3. To change the graph 
options click on the Graph Options button or choose Graph Options from 
the Options menu. The new options will be applied to all graphs in the 
current results window as well as to new results windows that are opened, 
but other results windows will not be affected. 
 

2.3 Results Manipulation 
Each segment displayed on a results sheet can be copied to another 
results sheet by dragging and dropping the segment text. The drag can be 
initiated anywhere on the segment’s text and a dashed bounding box will 
appear around the text. Drop 
the box onto another segment’s 
text and the segment will be 
inserted below the segment it 
was dropped on (unless the 
segment being copied is already 
on the results sheet). This is 
useful for overlaying multiple 
frequency response graphs that 
were generated with different 
sequence runs, adding power to 
MiniSonic in particular as it can 
only normally plot one response. 
 
Select Overlay all graphs from 
the frequency response tab on 
the graph options window to 
overlay multiple graphs.  
 
To delete a segment, single-click the segment text and press delete. A 
message box will appear asking you to confirm the deletion. 

 



 11

2.4 Comparing Frequency Response Graphs 
When testing microphones or equipment in a system with a known 
response error it can be useful to add graphs or subtract one graph from 
another. 
 
Click on the graph comparison icon on the toolbar to open the graph 
comparison window: 
 
Drag and drop the segment headers 
of the graphs onto the boxes labelled 
segment A and segment B. Note that 
the same segment can be dropped 
onto both boxes and that this 
facilitates the comparison of one 
channel with another from the same 
graph, see DPA4060 microphone 
results below. 
 
Left selects the left channel for 
comparison. 
Right selects the right channel. 
Both  selects both channels. 
Swap will swap the channels over.  

Select the form 
of comparison 
required (A+B or 
A-B), then bring 
the results sheet 
that you want the 
results to appear 
on to the fore by 
clicking on its 
title bar. Click 
Insert to insert 
the result. 
Depending on 
the settings 
either one or two 
new graphs will 
appear at the 
bottom of the 
results sheet. 
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2.5 Reading Results from the LA102 
Use the Device menu to read results from the LA102. This will read the 
results from the last sequence test, whether it was run directly on the 
LA100 or under computer control.  
 
The LA102 has 6 
results memories, 
numbered 0 to 5, and 
memory 0 is always 
used to hold new 
results. (The LA102 can 
be used to store up to 6 
sets of results by 
pressing * 2 and then a 
memory number to 
store the current 
results, from memory 0, 
in one of the other 
memories. Test results 
are stored in non-
volatile memory so they are preserved if the LA102 is turned off).  
 
A comment to be held with the results can be entered into the space 
provided, and the date and time will automatically be added to the results 
header. Comments can also be added/edited after the results have been 
received/loaded by double clicking on the text (see section 5.4 for further 
details). 
 
Click on the Read button to read the results (this should take about 4s, but 
will take longer on slow computers, or for large results files containing many 
frequency response sweeps).  If this fails, refer to the troubleshooting section 
in appendix A. 
 
Technical note:  Since the LA102 memory is shared and used for different 
purposes the number of results memories is sometimes reduced. In 
particular, results memories 4 and 5 cannot be used when user defined 
tolerances are held in the LA102, and the number of memories is also 
reduced if the 'number of compartments per memory' (LA102 configuration 
C) has been increased.  See the LA102 manual and V6.3/V6.5 update 
sheet for details.  Attempting to read from a results memory that isn‘t 
available will give a warning message. 
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2.6 Reading Results from the MiniSonic 
Click the Get button on the Control Panel to read results from a MiniSonic. 
The read process will take no more than one second and will read the test 
results from the last sequence test, whether it was run directly on the 
MiniSonic or under computer control. 
 
The MiniSonic (V3.0) can at present store one set of results in its memory 
and the results are preserved if the unit is turned off.  

2.7 Running LA100 Sequences 
The simplest way to run a sequence is to enter a list of segments (e.g. 
TRINCZ) into the text box provided on the far right of the toolbar or to the 
right of the status box on the Control Panel and press return. The ‘Run 
Sequence’ window will then open and messages confirming the progress 
of the sequence will be displayed. Once the sequence has completed the 
results will be retrieved and displayed automatically.  
 

 
 
The Run Sequence window can be opened by clicking Seq or Setup buttons 
on the Control panel, by choosing Seq/Run seq from the Menu bar or by 
clicking the SEQ button on the toolbar on the main. The sequence can be 
specified using any of the following methods: 
 
1. Choose a sequence bank from the drop down bank menu and then 
choose a sequence from the drop down sequence menu.  
 
2. Click in the Sequence field and enter a sequence number.  Note that 
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sequence numbers 1-10 are used defined; sequences 11-20 are the Lindos 
defaults etc.   
 
3. Click in the Sequence field and enter the segment. For example, TRCINZ 
could be entered directly in to this field. (Note that the 10 user defined 
sequences in the LA101 will be preserved and not overwritten). 
 
Click the Run button to make the LA100 run the specified sequence. If the 
sequence fails or an error occurs, refer to the troubleshooting section in 
appendix A. 
 
Various sequence options may be specified before running the sequence: 
 
The Channels buttons can be used to make the test sequence run on the 
left, right or both channels. Note that the left input of the LA102 is always 
used to decode FSK so the left LA102 input must always be connected, even 
if the test is only being performed on the right channel of a system. See 
section 3.11 on page 48 of the Lindos LA100 manual for more details. 
 
Monitor volume can be used to set the volume of the LA102 loudspeaker, 
but it cannot be adjusted once the sequence is running. 
 
22-22kHz filter switches in a band-pass filter to reject low and high frequency 
noise, outside of the audio bandwidth, It will affect the LA102 frequency 
response slightly near these frequencies, but the effect is minimal. 
 
Read results is normally enabled to make the computer read the results as 
soon as the sequence has finished. The results are displayed in a new 
results window. 
 
Open save box causes a dialogue box to be opened allowing the results to 
be saved to disc as soon as they have been read. This is convenient when 
performing a large number of tests as it saves time in opening the save 
menu for each test. 
 
Test level determines the level at which the sequence will be run. All of the 
test segments will be relative to test level and the FSK will also be at test 
level.  See section 3.7 on page 45 of the LA100 Manual. 
 
The Send only and Receive only buttons should be used if a sequence is 
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being generated but not received, or vice versa (for example, when testing a 
communications link, or when making a test tape).  
 
The Comment field can be used to enter a comment which is then stored 
with the test results and displayed in the results header. Note that comments 
can be entered/edited after the results have been read. Double click on the 
results text to bring up the ‘Results Format’ window. 
 
The Defaults button restores all of the other settings to their defaults.  

2.8 Running MiniSonic Sequences 
 
Enter a list of segments (e.g. nurqlz) into the text box provided on the far 
right of the toolbar and press return. The MiniSonic will immediately run 
and receive the sequence returning the results when completed. No 
progress confirmation is provided in Lin4WinXP when used this way, but it 
provides a very quick way of performing tests. In many test situations you 
may never need to open the Control Panel at all. Note that an option in 
Options/MiniSonic is provided to control whether or not the Control Panel is 
opened on start up.   

 
Open the Control panel and click Seq. The drop down menu below the 
function buttons will show “SEQ1 ‘Sweep’ u” and the sequence text box will 
display ‘u’. Use the drop down menu to select a pre-defined sequence and 
click Run or press return. 
 
Multiple sequences and repeating sequences can be run using the 
following commands: 

/n Repeat section between ‘/’ characters n times 
<n Repeat all sections n times – note that a stop button 

appears on the control panel. 
 

For example: 
u< will produce sweeps indefinitely and the frequency 

response results will be updated on the computer 
immediately after every sweep. 

n/u/2h  will produce nuuh as will n/u/u/h 
h/u/2<2  will produce huuhuu  

 
Note – It is not currently possible to include tone burst sequences using 
these commands. This will be corrected in a future MiniSonic firmware 
update. 
 



 16

2.9 Creating User Sequences 
 
Editing a pre-defined sequence in the sequence text box creates a user-
defined sequence. ‘User Sequence’ will appear selected on the drop down 
menu. To store the sequence for future use, rename the sequence by 
typing over the ‘user sequence’ text and clicking Seq. The new user-
defined sequence will appear selected in the list. To edit a user-defined 
sequence, select the sequence from the drop down menu and type the 
new list of segments into the sequence text box. The list of segments 
displayed on the menu will automatically update. To rename a user-defined 
sequence, type the new name over all of the text in the menu box and click 
Seq. To delete a stored sequence remove all of the characters from either 
of the boxes and click Seq. To save user-defined sequences for future use, 
name and Save the panel setup at the bottom of the panel window. Note 
that this also saves the frequency and level presets (see section 3.4 for 
further details). 

2.10 Large Graph Display 
Click on the Graph (full size graph) button after single clicking on a graph or 
double-click on the graph itself to display a large (full-screen) graph together 
with a frequency/level 
display, which allows 
the precise level to be 
read for any frequency. 
The frequency may be 
changed by typing a 
new frequency into the 
frequency box; by using 
the up/down buttons to 
change it in third octave 
or fine steps, as on the 
LA101 or MiniSonic; or 
by clicking over the 
graph with the mouse.  
 
All of the frequency response graphs in the results can be overlaid and 
plotted on the large graph by selecting ‘overlay all’ from the graph options 
window (see section 5.3). If any are not visible then they probably fall outside 
of the graph range and may be displayed by changing the graph scale in the 
graph options window.  
 
The MiniSonic can produce graphs of noise against time (segment l) and of 
level against level (segment h). The up/down buttons in the Graph Viewer 
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provide one-second and one-dB steps respectively for these graphs and the 
fine buttons step up and down point by point. The MiniSonic can also plot 
phase against frequency (segment z). 
 
A large number of graph options are available to change the size, grid 
density, scale, colour and overlaying of graphs. These options are accessed 
by clicking on the Graph Options button or via the Options menu see chapter 
4 for details. 

2.11 Tolerance Testing 
The tolerance testing system is based on the Lindos format described in 
chapter 5 of the LA100 manual and section 8.8 of the MiniSonic manual, but 
it has been extended to allow distortion limits optionally in % rather than dB. 
 
The Tolerance Definition 
For every result value recorded by a test segment there can be a 
corresponding tolerance string.  Each tolerance string can specify an upper 
value or a range and a maximum allowed difference between the two 
channels, in one of the following formats: 
 
 n Value must be less than or equal to n 
 ±n Value must be 0±n 
 n m Value must lie between n and m (space or sign separate 

n & m) 
 n±m Value must be n±m. 
 
Any of these forms can be followed by a difference specifier: 
 
 <d Channels (or registers) must match within difference d 
 
Note that the first form would normally be used for distortion, noise or 
crosstalk results, which must normally be below a certain limit (but there is 
usually no lower limit - they cannot be too good).  The second form (±n) 
would normally be used for frequency response, speed error or phase 
results, which should ideally be 0, although the third and fourth forms are 
often used for frequency response results where different upper and lower 
limits can be useful (eg ‘+2-3‘). 
n, m and d may be positive or negative, although the + sign is optional.  Most 
tolerance limits tend to be whole numbers, although decimal places are 
allowed.  In fact each value may be specified to a resolution of 0.0001 in the 
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range -9999.9999 to +9999.99 (the decimal part can be omitted for whole 
numbers). 
 
The units that are used depends on the test segment. For example, 
frequency response results will be in dB, while phase results will be in 
degrees.  
 
Choose Apply tolerance from the Tolerance menu item to apply a tolerance 
to the displayed results. Choose Edit/Transfer tolerance or click the edit 
tolerance button on the toolbar to start the tolerance editor. The Apply button 
provides a way of testing tolerances as you edit them. When clicked the 
tolerance will be applied to the results sheet that was last selected.  
 
Try loading a tolerance file supplied with the software (in C:/Program 
Files/Lin4WinXP/Tolerances). It is advisable to make a copy of the 
tolerances directory elsewhere for your own use before making any changes. 
 
The File menu allows 
tolerances to be 
saved or opened in 
the tolerance editor. 
Tolerances can also 
be applied by 
dragging and 
dropping them onto a 
results sheet which 
will also open the 
tolerance editor for 
ease of editing. It is 
also permissible to 
edit tolerances in a 
text editor, as they 
are just text files.   
 
Tolerances can be sent to or read from the LA102 by clicking Send or Read 
in the tolerance editor. Progress and confirmation messages for the read and 
send operations are displayed in the bottom left corner of the window. 
 
The quick tolerance icons on the toolbar offer two user tolerances and two 
Lindos grading tolerances for instant application. The action of the user 
tolerance buttons can be set up using the tolerance options window (click 
Options/Tolerance options - see section 5.6 for further details). 
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The Grade A and Grade B Tolerance buttons apply the Lindos-defined 
quality grading system: 
 
‘Lindos Grade A’ suggests a level of quality that produces no perceptible 
degradation whatsoever for most listeners in ‘blind’ A-B testing under the 
very best listening conditions. It is close to what would be expected from 
optimal ‘CD quality’. 
 
‘Lindos Grade B’ represents a level of quality that most people most of the 
time would find ‘near perfect’. The best compact cassette decks will meet this 
grade, using Dolby C or possibly Dolby B. 
 
Tolerances can be removed by clicking the Remove Tolerance button on 
the toolbar. 
 
The Options/Save options menu provides an option to save the tolerance 
information with the results file and by default this is turned on. When the 
results sheet is next loaded the tolerance will be automatically applied. Use 
the edit tolerance button to extract a tolerance from a saved file or to edit an 
applied tolerance.  
 
When a tolerance is applied to segments with graphical results the limits are 
marked on the graph with blue arrows. These can be changed to lines or 
removed using the graph options settings (see section 5.3.1). 

2.12 Printing Results 
Use the Print option on the File menu to print the test results.  
 
Printing uses a Windows printer driver that must have been set up as 
explained in the Windows manual. Any Windows compatible printer can be 
used, including Postscript and colour printers. Colour graphs will be printed 
on colour printers, but monochrome graphs can be printed instead by 
changing the Printer driver colour setting or by changing the graph options. 
 
Many other options are available to control the margins, headings, and text 
size of the printed results. See sections 5.3 and 5.4 for details. 
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2.13 Displaying Multiple Results 
Every time a new results file is loaded a new window is created, but this is 
not immediately apparent, as it will fill the main window, obscuring the 
previous results. Use Ctrl-Tab to cycle through results - this brings an earlier 
results window to the fore. Ctrl-Shift-Tab cycles in the opposite direction. 
 
Windows can be re-arranged using the Windows menu: 
 
The Cascade option will stack the windows so that the title bar of each 
window is visible.  The Tile option will show fit all of the results windows in to 
the main window, reducing them as necessary. 
 
The usual Windows controls can be used to maximise, minimise or iconise 
windows, and if results windows are iconised the icons can be neatly 
positioned using the Arrange icons menu item. 
 
At the bottom of the menu a list of the available results windows enables a 
particular set of results to be selected. 
 
To close and remove a set of results simply click on the close box, but note 
that this version will not warn if the results haven‘t been saved. 

2.14 Exporting Results via the Clipboard 
Results can be copied to the Windows clipboard and pasted into other 
documents. The clipboard is used to hold items being moved between 
applications and its contents may be viewed using the Windows Clipboard 
Viewer application. Items put on to the clipboard will remain there until 
overwritten by another item, or until Windows is shut down. 
 
To copy a set of results to the clipboard, click on the Copy to clipboard 
button. This will copy the current results text as plain ASCII text, and the 
graphs as a single Windows metafile (NB: text works but graphs currently 
have a problem). These can now be pasted into another application by using 
its Paste from clipboard button. If multiple sets of results are loaded ensure 
that the correct results are selected before using the Copy to clipboard 
button.  
 
Some applications will only be able to handle one type of data. For example, 
Microsoft Write cannot handle pictures so it will only paste the results text.  
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Most word processors can handle text and graphics metafiles although 
separate paste commands are needed to paste each item. For example, in 
Microsoft Word the Paste button will paste the results text, but the Paste 
Special command on the Edit menu can be used to paste the metafile graphs 
into a Word document. The graph can now be resized or cropped in Word by 
dragging or shift-dragging the corners of the bounding box. 
 
Since the graph is exported as a Windows metafile it can be scaled and 
printed without losing any quality and without requiring excessive amounts of 
memory. 
 
When results text is pasted into a word processor it should be set to use a 
non-proportional font, such as Courier or FixedSys to ensure that the 
columns line up correctly. 

2.15 Saving Graphs  
Graphs can also be saved as metafiles. Choose the Save Graph option on 
the File menu and save the file in the normal way. This will save a 
Windows metafile with a WMF extension, and this graphic file can then be 
loaded into another program, such as Microsoft Word.  The graph is saved 
exactly as it appears, so you should ensure that the correct graph options 
have been set before saving the graph (see chapter 4).  

2.16 Saving Results as HTML 
Choose the ‘Save as HTML’ option from the file menu and save the file in 
the normal way. An HTML file and a GIF file with the same name will 
appear in the chosen directory. The GIF, which contains all the graphs, is 
outputted with 256 colours and at a resolution of 72 dots per inch.    
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3. Control Panel 

3.1 Overview 
Click on the Panel button (or choose Panel from the ‘Device’ menu) to open 

the measurement Control Panel. This panel shows the oscillator settings in 
the top half of the window and the measurement options and measured 
values in the bottom half. Many of the buttons and icons provide help if you 
move the mouse pointer over them and the help often gives details of 
keyboard shortcuts as well as explaining what they are for.  

3.2 Measurement Options 
The five Function buttons select the current function, and most provide 
several options which can be selected from the drop down menu or by 
entering the option number into the box provided. For example, when using 
the LA102, Noise option 1 provides a CCIR Weighted quasi-peak 
measurement, whilst Noise option 8 provides an A-weighted measurement. 
 
The measurement function may be selected by clicking on one of the 5 
function buttons. These are Level, Noise, Crosstalk, Distortion and W&F 
for the LA102. When used with a MiniSonic a PPM (Peak Programme Meter) 
button is provided instead of W&F.  
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The options for each function are listed in chapter 2 of the LA100 manual 
and chapter 3 of the MiniSonic manual: 

3.3 Setting Frequency and Level  
The output frequency and level are set using the up/down buttons. 
 
The 3rd buttons change the frequency in third-octave steps (1000Hz, 
1250Hz, 1600Hz, 2000Hz etc), while the fine buttons change the frequency 
in fine steps (32 steps per octave on the LA102 or 12 steps per octave on the 
MiniSonic). Similarly the dB buttons change the level in 1dB steps while the 
fine buttons change the level in 0.01dB steps on the LA102 or 0.5dB steps 
on the MiniSonic. Typing new values into the fields and pressing return also 
changes the frequency and level. 
 
Note that the Lindos oscillators can only generate certain specific 
frequencies and the closest frequency available will be used. If True 
frequency is selected the actual frequency being generated will be 
displayed, otherwise the frequency will be rounded to the nearest third-
octave when it is changed with the third-octave buttons 

3.4 Frequency and Level Presets 
The ten frequency and ten level presets can be used to set a particular level 
or frequency with a single mouse click. The preset buttons can be assigned 
other frequencies or levels by manually setting the frequency or level and 
then holding the Ctrl key while clicking on the preset button (or by clicking 
and holding the preset button for two seconds). The button will turn yellow to 
confirm the change. To swap two presets drag and drop one onto the other.  
  

3.5 Setting the Output Channel 
The Left, Right and Mute buttons are used to select the output channels 
and the yellow highlight indicates the current state. Clicking on Left or Right 
turns that channel on or off, while clicking Mute turns both channels off or 
restores the previous state if they are already muted.  When a channel is off, 
the output is muted and terminated through a resistor so the output 
impedance is not affected. 
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3.6 Keyboard Shortcuts 
The following keyboard shortcuts work when the panel is selected as the 
current window: 
 
 F1 Frequency down (3rd octave steps or fine if shift is held) 
 F2 Frequency up (3rd octave steps or fine if shift is held) 
 F3 Level down (1dB or fine if shift is held) 
 F4 Level up (1dB or fine if shift is held) 
 F5 Range down 
 F6 Range up 
 Alt-L Measure left channel  
 Alt-R  Measure right channel 

3.7 Frequency, Phase and Level Measurements 
The Level, Frequency and Phase measurements are updated in real-time to 
show the values that the device is measuring. Note that when using an 
LA100 the Frequency and Phase measurement can be enabled or disabled 
by using the Freq button (see below). 
 
When measuring level using a MiniSonic the Left and Right channels are 
measured simultaneously and displayed as two separate bar graphs and two 
numeric values. The LA100 however only measures level on one channel 
unless ‘Level option 4’ is selected in which case both channels will be 
displayed. Since this requires rapid switching of the channel relays the 
update rate is rather slow. When using an LA100 or when measuring Noise, 
Crosstalk or Distortion with either unit only a single channel is measured and 
the L and R buttons may be used to select which channel is measured. 

3.8 Distortion Measurement 
When measuring distortion the level is displayed in dB, relative to the 
measured level of the fundamental. It is also displayed as a percentage.  
 
Both the MiniSonic and the LA102 measure the level of the fundamental 
briefly when the Dist button is clicked (for use in deriving a relative reading), 
so it is important that the Dist button is clicked again to re-measure the 
fundamental if its level changes. It is a good idea to click on the Dist button if 
in any doubt. 

3.9 Zoom Button 
The Zoom button expands the bar graph scale, and the Range buttons 



 25

change the bar graph range as well as locking the current range. The 
Autorange button toggles autoranging. Autoranging is automatically 
disabled if one of the Range buttons is used. 

3.10 Reset and Close Buttons 
The Reset button resets the unit and restores the default output frequency 
and level.  
 
The Close button closes the control panel. If using an LA100 it also puts 
the LA100 back into manual mode, thus allowing the LA100’s own front-
panel buttons to be used.  

3.11 Saving the Panel Settings 
The current settings in the Control Panel can be saved as a named panel 
setting. This can be particularly useful when production testing, where set 
levels or frequencies are repeatedly needed. Several settings can be saved 
and recalled, and the settings last used will be restored when the program is 
next loaded. 
 
To save the current state of the panel enter a name for the settings into the 
dropdown menu in the bottom left corner of the window and click the Save 
button. The frequency and level presets are saved as well as the sequence 
definitions and input and output impedance settings. The current frequency, 
level and channel settings are not saved.  
 
The Delete button allows the current panel setting (selected in the drop down 
menu) to be deleted. 

3.12 Bar Graph Speed 
The bar graph shows the current level, just like the bar graph on the LA102 
or MiniSonic. However, when using an LA102 the bar graph on the computer 
display will not be as responsive as the bar graph on the LA102 itself due to 
communication delays over the serial link. When using a MiniSonic, the 
computer display will be much more responsive thanks to the MiniSonic’s 
synchronised continuous data streaming system named SyncLink which 
updates the level information 110 times a second. This is fast enough to 
avoid obvious beating with the screen refresh rate (typically 60/75Hz). 
  
When using either unit the Freq button toggles frequency and phase 
measurement. If turned on the frequency and phase are measured and 
displayed but this will make the bar graph less responsive. Turn Freq off to 
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make the bar graph more responsive.  

3.13 Changing the output waveform 
The waveform type can be selected using the Waveform drop-down menu. 
The LA100 can generate sine, square, triangular and saw tooth waves as 
well as DC. The MiniSonic can generate sine waves or 1kHz, 5kHz or 10kHz 
square waves. 

3.14 Panel Features Specific to the LA100 
The LA101 output impedance can be set using the 10ohm, 75ohm or 
600ohm buttons. Note that the output impedance of the rear XLRs is always 
10ohms and that the front jacks are always 75ohm unless 600ohm is 
selected (this limitation applies when using the LA101 without a computer - 
see section 2.21 on page 30 of the LA100 manual).   
 
The ZC 600ohm option boosts the output level by an amount dependant on 
the selected output impedance, to generate the selected level into a 600ohm 
load. For example, when using 600ohm output impedance, selecting ZC 
600ohm will increase the output by 6.02dB. 
 
The Input Impedance buttons allow the input impedance to be switched 
between 600ohm or 10kohm.  
 
The panel bar graph shows the measured level and always shows the same 
value as the numeric display, unlike the LA102 bar graph which always 
shows the absolute level being measured.  For example, if, when measuring 
distortion on a +8dB tone the normalised distortion is -40dB then the bar 
graph and the numeric display will both show -40dB, whereas the LA102 bar 
graph would show the absolute level (-32dB). 
 
The L and R buttons are used to select the input channel.  
 
The Monitor volume slider controls the level of the LA102’s built-in 
loudspeaker. The volume may be changed by dragging the slider or by 
clicking to the left or right of it to decrease or increase the volume. 
 
The Automagic option can be enabled to make the software automatically 
set some obvious options. For example, when measuring crosstalk, it will 
automatically change the output channel if the input channel is changed, and 
when measuring distortion it will automatically choose the relevant distortion 
option if the LA101 frequency is changed. 
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4. Special LA100 Frequency Sweeps 
 

4.1 Running a Frequency Sweep  
 
Choose Frequency sweep from the LA100 menu or click on the SWP 
button to display the frequency sweep controls: 

 
Frequency sweeps can be run as part of an automatic test sequence and 
most of the supplied test sequences include a frequency sweep test, but it is 
often more convenient to use the frequency sweep menu, especially as it 
allows repeating sweeps. 
 
The frequency sweep mode uses standard frequency sweep segments, and 
the type may be chosen from the drop down menu. Note that the initial letter 
refers to the LA100 segment letter (see LA100 Manual, pages 39 and 70) 
and the different segments cover different frequency ranges and durations. 
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The level in dBu and the output channels can also be set before running the 
sequence, and correspond to the LA100 test level and sequence channel 
(see LA100 manual sections 3.7, page 45 and section 3.11, page 48 
respectively). Note that two-channel sweeps will take twice as long as single-
channel ones, so it helps to set single-channel operation wherever possible. 
The sweep is always generated on both channels - the channel setting 
determines which channels should be measured.  
 
The Repeating button determines whether the sweep will repeat 
continuously or just run once.  
 
To run the sweep, click on the Run sweep button. The computer will initialise 
the LA100 and run the sweep preceded by a test level segment to determine 
the headroom required. The results will be displayed when the sweep 
finishes, and another sweep will start at the same time if repeating sweeps 
are being generated. If the Big graph option was selected the frequency 
sweep will be plotted on a full-screen graph, otherwise it will appear in a 
normal results window, with the usual sequence heading and frequency 
response table. 
 
If the sweep fails or an error message appears refer to the troubleshooting 
section in appendix A. 

4.2 Stopping a Repeating Sweep 
To stop repeating sweeps click on the Stop button. The sweep will not stop 
immediately, but when the next sweep or pair of sweeps has finished 
(because the computer cannot interrupt the LA100 when it is running a 
sweep). 

4.3 Frequency Response Results 
If the Big Graph option was selected the results will now be available in a 
standard results window, as well as a large graph. If the Big graph option 
was turned off the results can be viewed full-screen by double-clicking over 
the results graph in the usual way. 
 
Frequency response results behave just like any other sequence results and 
may be saved, printed, or tolerance-checked in the usual way (see chapter 
0). 
 
Lin4WinXP can still be used while repeating sweeps are running although 
the system will freeze occasionally when the results are read from the 
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LA102. The frequency in the Large Graph window may be changed by 
entering a new value, or by using the up/down buttons, or by clicking over the 
point of interest. 

4.4 Notes and Precautions 
As with normal sequences, the left channel must be connected, even if the 
right channel is being measured, as the left channel carries the FSK which 
the LA102 uses for synchronisation. When testing sharp filters or other 
systems which block the FSK, connect the L channel directly between the 
LA101 and the LA102 and connect the right channel through the device 
under test see LA100 manual, page 49. Enabling direct triggering on the 
MiniSonic allows the sequence information to be passed to the measuring 
set internally (see page 9 of the MiniSonic manual). 



 30

5.  Options 

5.1 Options Menu 
The options menu can be used to set various choices, which determine the 
style of the results and also the default behaviour of various operations. 
When an option is changed and okayed the effect is immediate and the 
current option settings are saved to disc as the default settings so they can 
be used every time the program is run. 

5.2 Comms Setting 
Most PCs have at least one serial port, labelled COM1. If this is already 
being used, the LA100 may be connected to another serial port by setting the 
COM port number here (extra serial ports can usually be added by plugging 
in low-cost expansion cards). A USB to serial converter can also be used, in 
which case the COM port to which it has been assigned will need to be 
established from the Windows Device Manager (Start/Control 
Panel/System/Hardware). 
 

The baud rate and other communication settings are handled automatically 
by the program and need not be set (see appendix A if you suspect baud 
rate problems). 
 
When Lin4WinXP detects the presence of either a MiniSonic or LA100 the 
device type is automatically detected and the software customises itself 
accordingly. For example the MiniSonic’s monitor volume cannot be 
controlled remotely so the control is removed from the panel. 
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5.3 Graph Options 
The graph options window can be opened by clicking on the Graph Options 
button on the toolbar or through the Options / Graph Options menu:  

 
The tab buttons provide access to the options for different graph types. The 
General tab and the Frequency Response tab are always available, but the 
other options are only available when handling MiniSonic test results – they 
are not available with LA100 test results. 
 
The Defaults button restores the default graph options. 
 
The Try button redraws the relevant graph with the options as they are 
selected. It doesn’t save the new settings though so the Cancel button can 
be used to cancel the changes and revert to the previous settings. 
 
OK accepts the changes and uses them for the current results sheet (and 
also for subsequent results sheets which are drawn). 
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5.3.1 Graph Options: General Tab 
 

 
 
Left1, Right1 etc. These colour boxes are used to specify the colour of each 
plot. Left1 is used to plot the left channel for the first graphical segment, Left2 
is used to plot the left channel for the second graphical segment etc. Click on 
one of the boxes to change its colour using the standard Windows colour 
picker (See appendix C for details).  
 
The Grid colour can also be changed in the same way. 
 
The Line thickness setting alters the thickness of the grid. This can be 
useful with some laser printers for which the default line thickness is too 
narrow. 
 
The Labels option controls the font and font size used for labelling. (See 
appendix C for details of the Windows font picker). 
 
Show key causes a key to be drawn below the graph indicating which colour 
represents which graph. It can be turned off to save space. 
 
Mask determines whether the tolerance limits will be plotted over the graphs 
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when a frequency response tolerance is in use. Arrows causes small arrows 
to be plotted showing each tolerance limit.  Lines causes the tolerance 
points to be joined by straight lines, but note that tolerance checking is still 
only applied at the specified frequency points (ie the points listed in the 
frequency response table beside the graph).  
 
Mask is used to change the tolerance mask colour. Click on it and choose a 
colour from the standard colour picker. 

5.3.2 Graph Options: Frequency Response Tab 
The Frequency Response tab controls the scaling and layout of Frequency 
Response graphs: 
 
X range determines the scale used on the X-axis. If Auto is enabled the 
scale is chosen automatically for each graph. If Manual is chosen the 
minimum and maximum values may be entered manually. This can be used 
to zoom in on a particular frequency range. 
 
Y scale determines the scale used on the Y-axis. If Range is enabled then 
the range can be entered in dB in the range box. This is a sliding range 
automatically chosen to include the peak level in the graph, but extending 
over the specified range.  
 
Selecting Limits allows the upper and lower limits to be specified manually. 
These limits will be applied to all of the graphs, so they should only be used 
when the graphs are all around 0dB (ie when normalisation is being used). 
 
Grid density controls the number of horizontal or vertical grid lines. Setting it 
to Coarse will reduce the number of grid lines, while setting it to Fine will 
increase the number (the actual number of grid lines is determined 
automatically). 
 
Width and Height determine the graph width and height in cm. This setting 
affects graphs on the screen and on the printer, but the actual screen size 
will also depend on your monitor size and screen resolution (it is a good 
indication of the size though). 
 
Separate graphs causes each graph to be plotted on a separate graph.  
Overlay left/right pairs causes L/R pairs of frequency response plots to be 
plotted on the same graph but a different graph is used for different 
frequency response segments.  
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Overlay all will plot all of the frequency response plots on a single graph.  If 
any frequency response plots seem to be missing check that the Y-range is 
large enough to include them, or for frequency response graphs enable 
normalising. Note - this button is only visible when viewing LA100 results 
sheets. 
 
Normalise determines whether absolute frequency response graphs are 
plotted, or whether they are normalised to make them pass through 0dB at a 
particular frequency (315Hz, 400Hz, or more commonly, 1kHz). These 
options also recalculate the figures displayed in the frequency response 
listing. The dBSPL option is for use with microphones calibrated to give 0dBu 
in for 100dBSPL and is useful for displaying loudspeaker measurements in 
dBSPL (sound pressure level) rather than as the microphones output level in 
dBu. 
 
Normalise to source level causes each set of frequency response results to 
be normalised to the level at which it was generated rather than 0dB.  This 
has no affect on 0dB sweeps, but a sweep at -10dB would be normalised so 
that it passed through -10dB on the graph at the specified frequency. This 
can be useful when overlaying all of the frequency response plots on a single 
graph, but note that this is only available on the LA100 and relies on the 
figure displayed on the results sheet after the segment letter which is only 
present when a segment level specification has been used (e.g. TU+10).  
 
Normalise to test level causes each set of frequency response results to be 
normalised to the test level as measured by the unit (if a test level result is 
available). 

5.3.3 Graph Options: Other Tabs 
 
The options on the other tabs allow the appearance of additional MiniSonic 
graphs to be changed. The X range, Y range, Height, Width and grid 
density options behave exactly as described in the previous section. The 
Normalise and overlay all graphs options are not available.    
 
The distortion bar chart tab includes the option Show Grades. Un-ticking 
this option will remove the grey Lindos grading zones from the distortion 
bar chart.  
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5.4 Results Format 
The results format window can be opened by double-clicking on the text in 
a results window or by using the Options / Results options menu: 

 
The results format window is used to set print options and other results 
options. When OK is clicked the options are applied to the results sheet that 
is in focus and saved to disk as the default options for use when the program 
is next loaded.  
 
The four boxes available, labelled Equipment Make, Model, Type, and 
Settings can be used freely to contain any text. Users are urged to fill them 
in as indicated, especially when publishing results to the ‘Lindos Test Sheet 
Database’, because the database organises uploaded files automatically 
using these entries. The first three entry boxes are combined onto the first 
line of the results header, with the test conditions on the second line. A 
typical entry might read ‘Lindos - LSC24 - AD/DA Converter’ on the first line, 
followed by ’44.1kHz 16bit  Noise-Shaped’. 
 
A further box in the Results header group is labelled Comments and this can 
hold a large paragraph of text, which appears below the column of figures on 
the left hand side of the results sheet. It is suggested that this be used to 
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make comments on any faults, good features, or peculiarities that others 
might be interested in.  
 
Paper margins may be specified in cm to ensure that the printout has a large 
enough border for punching or binding. 
 
Font size for the results text may be set independently for the screen and 
printer. It is often useful for reducing the font size to ensure that the results 
will fit on the paper or the screen. 
 
Font name may be set independently for the screen and printer, but only 
fixed pitch fonts are available (such as Courier, Terminal or FixedSys) 
otherwise the results columns would not line up. 
 
Note that these options do not affect the graph labelling as the label font size 
is set in the Graph options (see section 5.4). 
 
Space between segment results can be used to add a small gap between 
each segment. A value of 4 points is recommended (note that 1 point is 1/72 
inches) and this is the default. 
 
Distortion units may be set to dB or % as required (-40dB is 1%, -60dB is 
0.1% and -80dB is 0.01%). This will apply to all distortion results and also 
tolerance specifications. The tolerance must be defined in dB, but it will be 
converted to % for the results display (note that printouts made directly from 
the LA102 always show distortion tolerances in dB). 
 
Mono print can be used when producing black and white printouts. Instead 
of plotting graph traces using coloured lines they will be plotted using thin 
lines using a different line style (this isn't entirely satisfactory as the lines 
will be too thin on many printers, but this may be improved in a later 
version). 

5.5 Save Options 
The ‘Save in Lin4Win2000 format’ tick box allows LA100 results sheets to 
be saved for use with Lin4Win2000 (an earlier version).  
 
‘Save Tolerances’ saves the tolerance string applied to a results sheet along 
with the results sheet data.  When the results sheet is next loaded the 
tolerance is automatically applied.  
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5.6 Tolerance Options 

Selecting Always apply current tolerance file will cause the tolerance file 
last applied to a results sheet to be applied to every results sheet loaded 
from disk (unless the saved file has a tolerance saved with it) or read from 
a unit. Note that when the software first loads user tolerance 1 will be 
applied if this option is ticked. 
 
The ‘Set user tolerance’ buttons allow the action of the quick tolerance 
icons on the toolbar in the main results window to be set up. Click to open 
a file dialog box, which allows selection of the tolerance file that is to be 
applied by the corresponding toolbar button.  
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6. Other Features 

6.1 Command Window 
A command window can be opened by choosing Command Window from 
the Device menu. It allows commands to be entered, and displays the 
responses of the unit. The Error checking facility automatically checks for 
LA102 errors after every command and displays an error message as 
appropriate. 
 
This facility can be used to control the LA100 or MiniSonic remotely, giving 
full access to all of their facilities, although its use is rather limited as it is 
usually easier and simpler to use the sequence or panel modes.  It can also 
be useful to try out commands when writing software to control a Lindos 
device. 

6.2 Tone Bursts 
Select Tone Burst from the Device 
menu or click on the TB button to 
open the tone burst window.  
 
Enter the frequency, duration 
and level and click on the Tone 
Burst button to generate the tone 
burst. These tone bursts are very 
accurate as the device handles 
the timing, rather than the 
computer, and the duration may 
be specified to a resolution of 
0.1ms in the range 0.1 to 
6553.5ms when controlling an LA100 or to a resolution of 1ms in the range 
1-255ms on a MiniSonic. 
 
Tone bursts always use sine waves beginning at a zero crossing. They can 
be made to finish on a zero crossing by setting a duration which corresponds 
to a whole number of cycles at the specified frequency (but remember that 
the device may not be able to generate the precise frequency that is entered 
(see page 184 of the LA100 manual for a full list of LA101 frequencies). 
 
Tone bursts are primarily intended for testing meters (PPM, CCIR etc) on 
other equipment. Various short bursts of specified durations are used to 
ensure that the meter reaches its correct target level. Note that tone-burst 
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generation segments are also provided for this purpose.  

6.3 Remote Display (LA100 only) 
The remote display option on the LA100 menu shows a live-copy of the 
LA102 LCD on the computer screen. This will be updated in real-time, and 
the LA102 may be used as normal (using the front panel buttons), although it 
may operate a little slower than 
usual. 
 
The remote display can be re-
started by double-clicking over 
the Remote Display window or by 
using the Remote Display menu 
again. When the window is 
closed the LA102 will return to normal operation. 
 
This can be useful for write-ups, demonstrations and teaching purposes.
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7. Uploading to the Test Sheet Database 

7.1 Introduction 
Lindos Electronics maintains an on-line database of test results for a wide 
range of equipment, which can be viewed at http://www.lindos.co.uk: or by 
clicking on the ‘world’ icon on the toolbar and then clicking the Open 
Database button. 
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The site is for all audio equipment, professional or consumer, including 
video equipment, MP3 players, camcorders etc. Users are invited to 
contribute their own test results for equipment and the Lin4WinXP software 
provides an upload facility to send test results to the Lindos Test Sheet 
database.  

7.2 Creating an Account 
Before uploading test results it is necessary to create an account on the 
database. Click ‘New Account’ on the database web page and set up an 
account by following the instructions and filling in the form. Make a note of 
your username and password for future logins. Anyone can set up an 
account and immediately upload results sheets: the uploaded test results 
will become public once the account has been approved by Lindos.  

7.3 Uploading Test Results 
After testing an item of equipment using the most appropriate test sequence, 
the Equipment Type, details and comments should be entered by double-
clicking on the results text (see section 5.4). Comments should be 
constructive, and aimed at helping the manufacturer as well as the user.  
Lindos will remove any entries it considers unsuitable. Users can edit entries 
they created but cannot edit other user’s entries.  
 
Select the results sheet to be uploaded by clicking on it and then click on the 
‘world’ icon at the right of the toolbar to open the login window:  
 

 
 
Enter your contact name (to be shown in the database) and the user name 
and password that were used to create the account and click Publish to 
upload the results. Progress messages will be displayed as the results are 
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uploaded. This process should take only a few seconds using broadband 
or 30 seconds on a modem. 
 
If ‘Remember username and password’ is ticked the login details will be 
saved for use next time the program is loaded. 
 
‘Batch publish’ allows all of the results sheets that are currently loaded into 
Lin4WinXP to be published at once. 
 
‘Open published results sheet’ opens the results sheet after it has been 
uploaded, as confirmation, in the default web browser set for the computer. 
 
The Open Database button launches the computer’s default browser and 
opens the Test Sheet Database from the Lindos website. 
 



8. Appendix A  Support & Troubleshooting 

8.1 Technical Support and Other Help 
For technical support please contact Lindos Electronics by phone, email or 
fax (contact details are given on the back cover). 
 
Note that many of the dialogue boxes provide help if you move the mouse 
pointer over a button or an icon and the help often gives details of keyboard 
shortcuts as well as explaining what the item is for.  
 
Please refer to the Lindos LA100 or MiniSonic manual for full details of the 
measurement functions, sequences and other features.  

8.2 Diagnosing Problems 
If LA100 communication fails, check the error message: 
 
LA100 is busy or not connected 
This means that the serial port CTS handshake line is busy. Ensure that the 
LA102 is turned on and connected to the correct serial port (note that an 
LA101 cannot be connected by itself without a dummy handshake plug). 
Choose Comms from the Options menu and ensure that the correct serial 
port is configured. 
 
Unit is not responding 
Ensure that the LA100 or MiniSonic is plugged into a serial port and check 
the Comms settings on the Options menu. If using an LA102 set the baud 
rate configuration B7 (9600 baud) as follows: hold ON/OFF and press 2, 
press PAGE or dB> until the cursor is under the letter R and then press *2 to 
select 9600 baud. Repeat this process on the LA101. Although the LA100 
Control software will attempt to communicate at all possible baud rates, there 
are some slow baud rates that the PC cannot use. 
 
LA102 responds but LA101 doesn’t and sequences fail 
Ensure that both units are connected and that they both display ‘REMOTE 
9600’ when under PC control. If the LA101 displays a different number, then 
set its baud rate configuration as described above. 
 
Serial Port COMx is Not Available 
The program has been configured to use a serial port which is not fitted, or 
which is in use by another program. 
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LA100 needs a firmware update 
This program will only work with LA100 units fitted with V6.0 or later 
firmware. Please contact Lindos Electronics for a firmware update if you see 
this message. The LA100 serial number and version number are displayed 
on the LCD when the unit is switched on. 
 
LA100 is in use 
This error indicates that the LA100 is already being used by another part of 
the program. If this occurs use the Reset Comms entry on the Device menu 
to clear it. If this fault can be repeated please report it to Lindos Electronics. 
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9. Appendix B New Features 
If you are upgrading from an earlier version of Lin4WinXP (previously 
Octolin), the new features are listed below:  
 

9.1 New in V2.0 
1. MiniSonic support added. 

 

9.2 New in V5.10 
1. Support for multiple graph types added 
2. New options for each graph type 
3. Quick Scale buttons added to toolbar 
1. Quick sequence box added 
2. Redraw problems fixed 
3. Graph cursor added to Big Graph Viewer 

 

9.3 New in V5.24 
1. Save options 
2. Tolerance options 
3. Quick tolerance buttons added to toolbar 
4. Upload to test sheet database facilities 
5. MiniSonic phase plot support 
6. MiniSonic delay measurement support 
7. Heading and comments systems revamped 
8. New MiniSonic sequence definition facilities 
9. Save web page option 
10. Automatic Userkey file downloading 

 

9.4 New in V5.30 
1. Frequency response graphs comparison tool 
2. Results cut and paste capability 
3. New normalising options (text + graph) 
4. Grid line-width option added



10. Appendix C File Formats 
All future software will adhere to these file formats, which have been carefully 
designed to be extendable and transportable between operating systems. If 
you write your own software to generate such files you are strongly urged to 
use these formats.  The formats described here are also compatible with the 
results format described in Lindos application note 17 (Paul Skirrow, third 
Edition, 31 Aug 93). 
 
Whenever plain ASCII text appears in a file the lines are terminated with CR 
(carriage return), LF (line feed) or CRLF pairs. In DOS and Windows the 
CRLF pair is used, but it is important that all software can handle text with 
any line terminator, as other operating systems use different terminator (BBC 
and Macintosh computers use CR while Unix and RISC OS systems use 
LF). 
 
See the supplied master disc for some sample files 
 

10.1 Sequence and Tolerance Files 
Sequence and tolerances files have the extension SEQ or TOL respectively 
and they hold a single sequence or tolerance definition per file. 
 
The definitions may extend over several lines and my include spaces. The 
line terminators and most spaces are removed when the sequence or 
tolerance is sent to the LA100. 
 

10.2 Results Files 
Results files have a .res extension and are used to store results from 
sequence tests, frequency sweeps, data logs and automatic test procedures. 
 
The first part of the results file holds the complete results text as seen on the 
printout or in the results window.  This is plain ASCII text using CRLF line 
terminators, but see the note above about handling CR and LF line 
terminators. 
 
The second part is optional and is used to hold graph data and other 
information in separate packets (a mono sweep is held in a single packet). 
The packet header is in ASCII text but the actual data is held in a compact 
binary form to keep the files small. 
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Tolerance information, which is also optional, will appear after the graph 
packets.  Again, this is plain ASCII text using CRLF line terminators, but see 
the note above about handling CR and LF line terminators. 
 

10.3 Results Header Lines 
The first few lines of the results text, up to the first blank line, contain file 
header information.  Subsequent lines represent the body of the results. 
 
The first line of a results file is the title, which indicates where the results 
came from. For example: 
 LINDOS AUDIO SEQUENCE TEST 
 

The rest of this line can contain a 42-character heading starting at character 
position 32 (ie spaces are used to pad up to this position). It will be filled in by 
the LA102 if the user has defined a heading in the LA102.  
 
The second line carries details of the sending and receiving systems.  The 
word ‘SOURCE’ is followed by the source ID (see section 4.3, page 67, 
LA100 Manual), as received from the LA101 in the FSK + segment.  This is 
followed, at character position 32, by the text ’LA102’ and the measuring set 
ID (the serial number and internal software version number): 
 
 SOURCE 0001Z                   LA102 0518  V6.5 

 
The third line contains the word ‘SEGMENTS‘, one or more spaces and a list 
of segments received on each channel (the lists are separated by one or 
more spaces): 
 
 SEGMENTS +TX  TX 

 
Subsequent header lines may be used for comments, and a blank line is 
used to indicate the end of the header text. It is recommended that the 
comments be restricted to 4 lines, but there is no limit.  A blank line should 
always follow the header lines, and must be totally empty.  A line containing 
a single space is not regarded as being blank (this allows multiple comments 
to be separated by a line containing a single space).  Tab characters are not 
used. 
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10.4 Results Text 
The actual results follow with a section for each test (usually each test 
segment). Each section has a title line giving the title of the test and the test 
name in square brackets. For Lindos test segments the test name is simply 
the segment letter. Title lines can be detected by looking for the square 
brackets.  Subsequent lines up to the next title line contain results for that 
test segment.   
 
For example: 
 TEST LEVEL OUT [T] 0dB  
           +0.11    -2.65dBu  
 DISTORTION (2f-22k) [D] +8dB 
  100Hz    -72.8    -73.0 
   1kHz    -94.3    -91.4  
 6.3kHz    -72.8    -77.3  
 PHASE (mean) [Z] 
   40Hz      -0d   
  100Hz      -1d  
   1kHz      -4d  
 6.3kHz      -7d  
  10kHz     -37d  
  15kHz     -28d  

 
The precise format of the results lines is: 
 8 character measurement title  
 7 characters containing the L channel results 
 2 spaces 
 7 characters containing R channel results 
 Any other text 
 
The values are right justified in the 7 character field width, but the decimal 
points may not be aligned, as some values may use more decimal places 
than others (test level and frequency response results have 2 decimal 
places; distortion, crosstalk and noise have 1; phase results have no decimal 
places; W&F results have a variable number).  The results value may also 
have a units suffix, such as d for degrees, or % for percent. 
 

10.5 Graph Handles 
Frequency sweep segments will normally generate graphs as well as text. 
The graph data follows in a graph packet (see below) and a graph handle is 
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used to indicate which graphs are associated with each test.  
In such cases the title line has one or more ^ characters at the end of the 
line, each followed by the graph handle. For example, if frequency sweep R 
generated two graphs with graph handles 1 and 2, then the title line would 
be: 
 
 FREQUENCY RESPONSE [R] -10dB^1^2 

 
It is best to remove this suffix when displaying the results to aid clarity, but 
always store them in results files. 
 

10.6 Packet Data 
The packet data is optional and will normally only occur in results files that 
contain graphs or tolerances. 
 
An end of text (ASCII 26) character is used to mark the end of the ASCII text 
section and the start of the packet data. This is followed by one or more data 
packets each starting with the following two lines which form a packet 
header: 
 
 type, format 
 n,m 
 
type is a case-insensitive string specifying the packet type, while format is a 
number representing the format. n indicates the number of lines of text in the 
packet header (not including these two lines) while m is the number of bytes 
of binary data that follow.  Each line of text in the header is terminated with a 
CR (ASCII 13) character and n and m may be zero. 
 
When reading results files unknown packets must be skipped using the 
values of n and m to skip over the unwanted lines and binary data bytes 
respectively. 
 

10.7 The Graph Packet 
The Graph packet has the following packet header: 
 Graph,format 
 5,m 
 xunits,yunits 
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 handle  
 x1   
 x2   
 s 
The keyword Graph indicates that this is a graph packet and the format 
indicates which graph format is used: 
 0 Linear X and Y axes 
 1 Logarithmic X, linear Y axes 
 2 Linear X, logarithmic Y axes 
 3 Logarithmic X and Y axes 
 4 Bar chart ### 
 
If the format is not 0-3 then the whole packet must be ignored.  Only formats 
2 and 3 are used by current software. 
 
m is the number of bytes of binary data that follow.   
 
xunits and yunits are strings representing the units to use when labelling the 
graph. For a logarithmic frequency sweep these would normally be Hz,dB 
respectively , and for a time plot, they would be s,dB. 
 
handle is a number representing the graph handle and is used to link the 
relevant part of the results text with the graph. This handle can be used to 
loop up the test title (see section D.5). 
 
x1 and x2 represent the first and last values to plot on the x axis. For a 20Hz 
to 20kHz sweep these values would be 20,2000. 
 
s is the number of samples in the packet. This is typically 256 for a LA100 
generated frequency sweep, but other the values will occur for other results 
graphs. 
 
The actual graph data follows using 2 bytes per sample (ie m will always be 
2s) with the first sample corresponding to x1 and the last corresponding to 
x2.  If a linear x axis is in use (format is 0 or 2) then the points represent 
samples at equal intervals. If a logarithmic axis is in use (format is 1 or 3) 
then the samples were made using a pseudo log scale . A logarithmic scale 
will give reasonably accurate results, but for best results the LA100 pseudo 
logarithmic scale should be used (see LA100 manual for details). 
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Each sample is 2 bytes, integer byte first, followed by fractional byte, using 
two‘s complement fixed point binary.  This is the same format that the S? 
command generates - see page 146 of LA100 Manual for more details. 
 
See the example results files provided for an example. 
 
For example, a typical graph packet header will look like this: 
 
 Graph,1 
 5,512 
 Hz,dB 
 1  
 20  
 20000  
 256  

 
This will be followed by 512 bytes of binary sweep data. Other graph packets 
may follow and note that a stereo frequency sweep will produce two graph 
packets. 
 
Lin4Win2000 results files require each line of the graph header to be prefixed 
with a null character followed by the character that has an ASC value equal 
to the number of characters on the line. Note that these are non-printable 
characters and they will appear in a text editor as �. 
 
E.g. 
 ��5,512 
ASCII 0,5,53,44,53,49,50 

10.8 The Tolerance Packet 
 
Tolerances can be saved with results sheets by specifying a tolerance 
packet at the end of the file. 
 
The tolerance packet has the following packet header: 
 
 TOL, 

 
The header should immediately follow the last graph packet (no separating 
characters should be used). The text following the comma contains the 
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tolerance definition (see section 2.8 for details on how to define a tolerance).  
 
e.g. 
 
 TOL,"MS10 Self-Test" 
 w±.1,±0.1,±.25,,+0-1.0, 
 uvs±.5,,±.25,±.15,,,,±.15,, 
 t±.1 
 n-78 
 m-60 
 r-55,-65,,,, 
 c-75,-70,-68 
 l?,-65, 
 z±20,±20,±20  

 
 

11. Appendix D Key Shortcuts 
There are several key shortcuts, and most are listed on the relevant menus 
and buttons.   
 
In the results window: 
 Ctrl-O Open new results 
 Ctrl-S Save results 
 Ctrl-P Print results 
 Ctrl-Q Run sequence 
 Page Up/Down Scroll results up/down by a page 
 Cursor up/down Move results up/down by a line 
 
In the Control Panel: 
 F1/F2 Change frequency (hold shift for fine) 
 F3/F4 Change level (hold shift for fine) 
 F5/F6 Change range  
 F7 Left output on/off 
 F8 Right output on/off 
 F9 Mute both output channels/restore outputs 
 Alt-L Select Left input 
 Alt-R Select Right input 
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12. Index 

A 

Auto-magic 29 
Autorange button 27 

B 

Bar graph 27, 28 
Baud rate 32 

configuration 46 
Big Graph 30, 31, 48 

C 

CCIR 41 
CCIR Weighted 23 
CD 19 
Clipboard 21 
Close button 27 
COM port 32 
Command Window 41 
Comment 15 
Comms 5, 6, 32, 46, 47 
Connecting leads 5 
Control Panel 6, 13, 15, 23, 24, 27 

D 

dB buttons 24 
Defaults 15, 33 
Direct trigger 31 
Distortion measurement 26 
Distortion units 39 

E 

Edit Tolerance button 18 
Error checking 41 

F 

File formats 49 
Freq button 28 
Frequency 24, 26, 29, 30, 31, 52 

display 24 
measurement 24 
presets 24 

Frequency response graphs 35 
comparing 11 
overlaying 17 

Frequency sweeps 30 
FSK 14, 15, 31, 50 
Function buttons 23 

G 

GET button 13 
GIF resolution 22 
Grade A 19 
Grade B 19 
Graph handles 52 
Graph options 10, 33, 39 
graph range 35 
Graph Viewer 17 
Graphs 

absolute 36 
distortion bar chart 37 
noise against time 17 
overlaying 36 
plotting separately 36 

Grid colour 34 
Grid density 35 

H 

HTML 22 
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I 

Input channel 28 
Input impedance 28 

K 

Key 6, 35 
Key shortcuts 55 
Keyboard shortcuts 26 

L 

Labels 34 
Large Graph Display 16 
Level 24, 28, 30, 36, 41 

presets 24 
Limits 35 

M 

MDI 7 
Measurement options 23 
Microsoft Word 21 
Monitor volume 14, 28 
Mono print 39 
Multi-document 7 
Mute button 24 

N 

Normalise 36 
dBSPL 36 
to source level 36 
to test level 36 

O 

Options menu 32 
Output channel 24 
Output frequency 24 

Output impedance 25, 28 
Output level 24 

P 

Packet data 52 
Panel settings 27 
Phase 26 
PPM (Peak Programme Meter) 24, 

41 
Preset buttons 24 

programming 24 
swapping 24 

Printing 20 

Q 

Quality 19 

R 

Read results 14 
Reading results 12, 13 
Receive 15 
Remote display 42 
Remove Tolerance button 19 
Repeating frequency sweeps 30 

big graph option 30 
Reset button 27 
Results 

files 9, 49 
manipulation 10 

Results Format 38 
Results sheet 39 

S 

Save options 20 
Lin4Win2000 39 
tolerances 39 

Segment 
spacing results 39 
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Send 15, 19 
Sequences 9 

LA100 13 
MiniSonic 15 
repeating 15 
user defined 14, 16 

Serial port 32 
Sine waves 41 
Software update 47 
SWP button 29 
SyncLink 27 

T 

Technical support 46 
Test level 15 
Test results 7, 15, 20 
Test sheet database 38, 44 

creating an account 44 
introduciton 43 
open database 45 
uploading test results 44 

Tolerance 4, 9, 17, 19, 39, 49, 50 
always apply 40 
arrows 35 
definition 17 
editor 19 
graphical representation 20, 35 
mask 35 
options 40, 48 
packet 54 
set user tolerance 40 
string 17 

Tone bursts 41 
Tool bar 7 
Troubleshooting 46 
True frequency 24 
Try button 33 

U 

Up/down buttons 17, 24 
Userkey file 7 

V 

Version history 48 

W 

Waveform 28 
Width 35 
Windows menu 20 
Windows metafile 21, 22 
Word processors 21 

X 

X range 35 

Y 

Y scale 35 

Z 

ZC (Impedance correction) 28 
Zero crossing 41 
Zoom 27 




